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1. Introduction

This document includes important installation, safety, maintenance and basic
configuration instructions for wireless Outotec CellSensor™ electrolytic cell
voltage and temperature measurement system. It is written for metallurgists,
process engineers, electricians and instrumentation staff or whoever is working
with the system. Reader should have basic knowledge on the industrial
instrumentation, control systems and data communication. Also basic PC
computer skills are assumed.

It is strongly recommended that the manual is carefully and completely read
before operating the system. Failure of following the instructions may lead to
serious personal injury or damage of equipment and avoid warranty.

The manual includes
= an introduction to the structure and operation of the CellSensor system
= instructions for operator and electrical safety

= instructions for installation, commissioning and maintenance of the system
components

= description of the data interfaces

All tasks described in this document are to be performed according local
regulations, safety rules and procedures that apply. Make sure that you are
qualified to perform any tasks or modifications described in this document.
Changes to the settings not described in this manual or any other changes ror
service to the device electronics, materials or structures are to be carried out by
Outotec or a vendor authorized by Outotec only.

The CellSensor™ system is designed for advanced monitoring of copper, zinc,
nickel, cobalt and aluminum electro-refining and —winning cells and processes.
Do not use it for any other purpose or in other processes.

This manual is compatible with CellSensor System version 1.1 and higher.
Outotec CellSensor™ and CellSense™ are trademarks of Outotec Oyj and

incorporate technologies that are protected by international patents with
exclusive rights to Outotec Oyj.

1.1 Contact Information

In case of technical questions or more information, please use the following
contact information:

Outotec Oyj
Riihitontuntie 7C
02201 Espoo, FINLAND

+358 (0) 20 529 2111, hydro@outotec.com, http://www.outotec.com

OUTOTEC
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2. CellSensor System

Outotec CellSensor system is a powerful data collection system for electro-
refining and -winning cells, based on robust and reliable wireless
communication and powered by the low cell bus bar voltage. The system
provides accurate, calibration free and superior quality measurements for

= Cell voltage (V), and

= Cell electrolyte temperature (°C or F)

Truly wireless sensors located next to cells minimize the required cabling and
associated maintenance and make the installation simple and clean.

CellSensor system provides unrivalled functionality. Instant cell by cell short
circuit detection based on cell voltage measurements allows improved current
efficiency, reduced energy consumption, increased production and permanent
cathode longevity. Electrolyte temperature monitoring and control of each
individual cell enables enhanced cathode quality and plating time, early action
for process disturbances and electrolyte flow based problems and optimised
additive consumption.

The proprietary wireless network is based on the architectures of IEEE 802.15.4
and it takes care of reliable and robust transfer of data acquired by CellSensors.
The network is formed and maintained automatically between the devices. The
data is stored at CellSense Server PC for convenient data presentation through
web based and user friendly CellSense monitoring system. Interfacing of third
party systems such as Historians or DCS systems is also possible with OPC,
ODBC or web browser.

2.1 System Components

The system consists of three types of wireless devices and a Server PC.

= CellSensor (CS) — Measurement sensor device installed to an electrolytic
cell. Labelled with network address, e.g. 0103, OFOA. (See 2.2.3 for
network addressing)

= Coordinator (CN) — Network Coordinator routing data from CellSensors to
Gateway devices. Labelled as CN-XX, where XX is the network address of
the device.

= Gateway (GW) — Central linking device transferring measurement data of
CellSensors via Coordinators to Server PC over USB cable. Labelled as
GW-XX, where XX is the network address of the device.

= CellSense Server PC — Measurement data presentation and storage and
data interface server to third party systems. Hosts also CellSense
monitoring system and web based user interface.

All the wireless devices are physically similar but the functionality is different
depending on their role in the system. The role is defined in the configuration of
each device. The type of each device can be identified by the address label
attached to the device and wiring used.

OUTOTEC
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CellSensor (CS)

OUTOTEC

The general structure of the system and location of the components in a tank or
cell house is shown in Figure 1 below.

CellSense
Server

Gateways

Wireless
Data Flow

CellSensors Web Monitoring PCs

EWI/ER Cells

Figure 1. General Structure of the CellSensor System

CellSensor device is attached to an electrolytic cell with a simple mounting
mechanism. Each unit is capable of measuring the cell voltage and electrolyte
temperature of either one cell or two adjacent cells.

Installation of the device is simple. The device is connected to the cell bus bars
with short lead wires of about 4 mm? cross section (AWG 12). CellSensor is
powered by the low cell bus voltage it measures. The temperature probe is
placed into the cell and connected to the CellSensor. The system requires no
calibration which furthermore simplifies the installation and maintenance. Once
the CellSensor is powered, the wireless measurement data transmission is
started automatically.

A typical CellSensor mounted on a commercial cell is presented on the Figure
2.
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Figure 2. CellSensor Device Installed to an Electrolytic Cell

As shown in the general block diagram in Figure 3, CellSensor device consists
of a small electronics Printed Circuit Board (PCB) with

= Powerful on-board signal processing (microprocessor)

= Integrated antenna for communication over 2.4 GHz ISM radio
(IEEE 802.15.4)

= Voltage booster for power management
= Two input terminals
= T1 for bus bar cable connections
= T2 for temperature probe connections
= Holder for back-up battery
= LEDs for status display

= Ambient temperature sensor for automatic temperature compensation and
diagnostics

ve et ot et e e et —
Cells ) |
| 06V~ ( W LS l
3.8V CellSensor 1
I . : DCmc i N 337
Cell # > Protection Booster "| Regulator |
| L Circuit
' |
l 33V 1
A
Cell #2
2 ) Ambisrt (i A ;
Temperature PID/PWM — I
I Sensar — 3.6V 1
Digital | | AD -] .
Temperature | Ch L Rechargeable Internal |
oropep | Li-lon Battery ANEGna:
|} Donal \
[ — UUEALIE v :
Probes2 | (———— 1
| Protocol - 2.4GHz Radio !
l Software I
: |
| - Serial Port Microcontrolier 1
l \ J |
-

CellSensor

Figure 3. Block Diagram of the CellSensor Device

OUTOTEC



User Manual

Code CSS-001

Revision 1.04 Page 9 (72)

The CellSensor board is capsulated and protected in with an IP65-sealed
polycarbonate box (168x140x80) mounted on a profiled stainless steel
(AISI316) backing plate. The plate is used for attaching the CellSensor to the
cell.

Refer to chapter 4 and Appendix 2 for proper installation and wiring options of
the device.

Input Terminals and Push Buttons

OUTOTEC

Input terminals T1 (voltage) and T2 (temperature), battery plug J5,
communication port (Gateway) J3 and Reset button are shown in Figure 4
below.

In Figure 4 the standard bus bar cables with colour scheme are shown (shipped
with the CellSensor devices) and the communication wires of the two
temperature probes are properly connected. Back-up battery is also connected
with battery plug J5. Communication port is used only by the Gateway device
(the pin order is defined in the Appendix 4).

BACK-UP BATTERY

COMMUNICATION PORT
BUS BAR END OF THE WIRE GATEWAY ONLY

\ ey

S2 BUTTON

S1BUTTON

RESET BUTTON

TERMINAL T1 (BUS BARS)

TERMINAL T2 (TEMPERATURE)
PLUG

o
—-!' D1 - PROBE 1

[ '_,} ]

D2 - PROBE 2

L

Figure 4. Input Terminals, Battery Plug, Communication Port and Push Buttons
of the CellSensor, Coordinator and Gateway devices.

Terminal T1 is used to measure the cell voltages and also to power up the
device. The port is classified for CAT | voltage measurements and it should not
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be connected and used for CAT II-IV rated measurements. The maximum
continuous input voltage for the T1 terminals is 25 V.

Ports of the voltage terminal T1 are described in Table 1 below. T1 is not used
by Coordinator or Gateway devices.

Table 1. Description of Cell Voltage Terminal T1 of CellSensor

T1 Port Cable Description

Common Ground
CD- Black AD1+ and AD2+ are measured against CD-
Voltage Booster Ground

Voltage Input Channel 1 (0-2.5V (ER)or0 -8V
AD1+ Red (EW))
Voltage Input for powering the CellSensor device

AD2+ Blue Voltage Input Channel 2 (0—-2.5V or0-8YV)

Refer to Appendix 2 for different and correct wiring alternatives.

Ports of the temperature terminal T2 are described in the Table 2. T2 is not
used by Coordinator or Gateway devices.

Table 2. Description of Temperature Terminal T2 of CellSensor

T2 Port Probe Wire Description

D1 Probe 1 — Brown Probe 1 channel (signal)
D2 Probe 2 — Brown Probe 2 channel (signal)
D3 NA Not Used

GND Probe 1, 2 — Blue Common ground

V+ NA Not Used

OUTOTEC
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The functionality of the push buttons Reset, S1 and S2 are described in the
Table 3 below. The push buttons provide restricted and local interface to
interact with CellSensor System devices (set network address, channel,
transmit data, reset (boot), etc.). The buttons can be used anytime during the
system component is running.

Table 3. Description of the Push Buttons

Action
Button CellSensor Coordinator / Gateway
Reset Restart of the device Restart of the device
S1 Manual command to .
transmit data. Not in use
Manual command to switch Not in use
to Boosting Mode.
sS2 If the input voltage is out of

operating are, device
switches immediately back
to Power-Saving Mode

1. Push Reset Enter network setup mode / Enter setup mode /

2. Reset + S1 Check network Check network configuration
3. Release Reset configuration -Network address

4. Release S1* -Network address - Channel

* Do not unnecessarily make any change to device settings! These settings
are critical to system performance and function. Consult Outotec support in any
concerns before any configuration change. See Chapter 6.3 instructions for
changing the configuration with push buttons.

Voltage Booster and System Modes

The innovative voltage booster in CellSensor makes it power self-sufficient and
a true wireless device. It is powered by the energy harvested from the "endless"
power source — electrolytic cell. The booster is able to boost the input voltage,
or cell voltage, from as low as 0.16 to above 4.0 V, so that the CellSensor will
be able to work with wide range of electrolytic cells and also cells under very
bad condition (low cell voltage).

The two operational modes of the CellSensor device are shown in Figure 5. The

active mode is indicated for the user by the LEDs on board (see Diagnostics
chapter 5.2).

OUTOTEC
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0.16% < Input Voltage < 4.00%

ower buffer time period

FPower Saving
Made

Boosting Mode

Input Woltage = 4.00%, OR
Input Woltage < 0.16%

Figure 5. The Operating Modes of the CellSensor Device.

When the input voltage is between the normal operating range (0.16 V — 4.0 V)
the CellSensor is in boosting mode, which is the normal mode of the device. In
boosting mode the device is powered by the booster directly.

A rechargeable Li-lon battery is equipped as a backup power supply in case the
external power source becomes unavailable. During the boosting mode the
battery will be charged by the booster circuitry and kept full. The output voltage
of the booster is controlled and regulated by the on-board microprocessor with
advanced high speed digital PID controller.

The battery will be automatically switched in when CellSensor enters power-
saving mode. This will happen in two conditions:

= if the cell is powered down e.g. during cathode harvest, maintenance and
cut-in/cut-off of other sections in the rectifier circuit during operation

= f the self diagnostic of the CellSensor indicates a poor tap contact
condition (see Diagnostics)

Entering power-saving mode is automatic. The CellSensor continues to
measure and report the temperature and voltage normally but with slightly
decreased scan rate. The mode is automatically switched back to boosting
mode when the input voltage recovers back to normal operating range and the
tap contact condition is good. Continuous power-saving mode can last up to 5-7
months depending on the scan rate and data transmission intervals specified for
the mode.

Voltage Measurement Range and Resolution

OUTOTEC

The voltage measurement range is not depended on the normal booster input
voltage operating range (0.16 — 4.0 V) or the system mode. CellSensor device
measures and transmits the voltage data normally in both system modes.

There are two voltage measurement range options available depending on
electrolytic cell the CellSensor is measuring.
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Temperature Probe

= For Copper Refining (ER): 0-25V
= For other electro-refineries (EW) 0-80V

The resolution of the voltage measurement is 0.0024 V.

A calibration free and high precision digital temperature sensor is used for the
electrolyte temperature measurement. It measures temperature from -55°C to
+125°C and has a guaranteed accuracy of +0.5°C with a resolution of 0.0625°C
over -10°C to 85°C range.

The temperature probe is a one-meter long and 6 mm diameter stainless steel
(AISI316) tube coated with polypropylene, which makes it chemically resistant
to the electrolyte. The temperature sensing element is located at the end of the
probe tube and it is protected by a polypropylene cap filled with silica glue. The
sensing component is a small footprint digital semiconductor device that is
linked with two wires (blue-signal, brown-ground) to the T2 terminal of
CellSensor (see Appendix 2 for wiring). The microprocessor of the CellSensor
contains customized drivers to optimise the sensor performance and the
measurement quality.

The probe is delivered as a straight tube. During the installation the probe is
formed (e.g. bent) to suit the cell design with standard instrumentation tools.
Installation and commissioning of the temperature probe is plug and play. Once
the temperature probe is formed to suit the cell and is attached properly to the
terminals of a CellSensor, it automatically starts the transmission of the
temperature data.

Data Acquisition and Filtering

OUTOTEC

CellSensor device is very closely located and electrically floating to
measurement point, which guarantees high precision and quality
measurements. The noise caused by the harsh tank or cell house environment
(strong magnetic fields, dirty bus bars, short circuits between anode and
cathode, etc.) is minimized because of short wiring and closely performed
digitalisation with high frequency sampling. The CellSensor measurements
require no calibration and it automatically compensates for the effect of the
ambient temperature changes to the measuring device electronics.

The CellSensor samples cell voltage and temperature with the scan rates that
are defined by the user (default 15 seconds, minimum 3 seconds). CellSensor
transmits the voltage and temperature measurements in case either the
following conditions apply after each measurement scan:

= Scanned measurement value has changed over 1% from the previous
value

= Time of the last report has exceeded 1 minute

The CellSensor activates its radio only for the period of data transmission.
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Diagnostics

Coordinator (CN)

OUTOTEC

Each CellSensor device monitors its status continuously:

= Bus bar cable tap contact quality (1 = Good, 0 = Poor (Alarm))
= Battery voltage (V)

= Communication link status (1 = Good, 0 = Lost (Alarm))

=  Ambient temperature (°C or F)

The diagnostic information is routed up to CellSense Server and is available
through all data view and interface options. The diagnostic data is updated once
per minute.

CellSensor device is also equipped with four LEDs on board to present the
operating mode and status locally for the user. See chapter 5, Diagnosing the
System, for more detailed information.

CellSensors can associate only with Coordinator devices.

A Coordinator has three functions in the CellSensor Network:
= Master of the CellSensors attached to it
= Manage the PAN it forms (Personal Area Network by IEEE 802.15.4)

= Route the measurement data up to Gateway device.

Coordinator keeps the radio always on and receives the measurement and
diagnostic data each attached CellSensor send. The information is placed in a
small buffer and forwarded to Gateway device once the buffer gets full or the
buffer timer expires.

Figure 6. Coordinator Device Mounted on a Tank House Wall. External Power is
fed from the PSU to Coordinator with an external cable.
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Gateway (GW)

OUTOTEC

Each Coordinator is able to manage up to 200 CellSensors up to 50-200 meter
range. The communication range depends on the tank house shape, equipment
and materials. The maximum number of the Coordinators in the CellSensor
Network is 40.

The amount of Coordinators required by a CellSensor system depends not only
by the number CellSensors installed and communication range, but also for
making sure that fully redundant communication paths are available for each
CellSensor. Each CellSensor should always be able to reach at least two
Coordinators.

Coordinator devices should be located e.g. on the walls of a tank or cell house,
typically about 2 — 5 meter high to ensure good communication coverage and
non-hindrance to moving cranes or other equipment and tools.

Coordinators are powered by mains connected to external and small Power
Supply Unit (PSU) (see Chapter 4 for specification and Appendix 2 for wiring).

Coordinator device can associate with a Gateway device, that is connected with
CellSense Server PC over USB cable. Like Coordinator, the Gateway device
includes external and small PSU (Power Supply Unit) for powering the device
(see Chapter 4 for specification and Appendix 2 for wiring).

There can be up to two Gateway devices in the CellSensor Network.

A Gateway device has three functions in the CellSensor network:

= Receive data routed by Coordinator devices and push them to CellSense
Server PC

= Manage the PAN it forms (Personal Area Network by IEEE 802.15.4)

=  Manage the Coordinators attached to it

Gateway keeps the radio always on and receives the data routed by
Coordinator devices and buffers them in a small buffer. The buffered data is
pushed to the USB once the buffer gets full or when the buffer timer expires.
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Figure 7. Gateway Device (smallest box) mounted on the wall of a cell house.

Communication Cable and Options

By default, the communication between Gateway and CellSense Server PC is
over USB line that is shipped with the Gateway device. The Gateway serial port
supports TTL, so an USB cable with integrated TTL converter in the USB plug
is connected to the serial port. The USB plug can be connected to any USB port
of PC or extended with another USB cable or extender device. See Appendix 4
for the cable and Gateway serial port specification.

In special cases a RS232 cable with integrated TTL converter can be used and
shipped on special request. This option is needs to applied if serial to Ethernet
converters are used between the Gateway and CellSense Server PC.

The recommendation for the maximum single USB line length is 5 meters. In
case longer distance is required, the following options are available:

= Use active USB extender(s) or Hubs
= Use fiber optic converters for USB line (in case the line is really long)

L] Use serial to Ethernet converter to enable Ethernet connection with the
Gateway device. This option requires serial cable (RS232/TTL) to be
instead of USB cable.

OUTOTEC
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CellSense Server PC

CellSense Server PC is a standard server class PC running Windows 2003
Server OS. CellSense Server has several important functions in the system.

= Runs CellSensor Driver to read, store and publish the CellSensor
measurement data

= Configuration of the driver (see chapter 4.5)
= Hosts CellSense Monitoring System
=  Raw measurement data refining into more clear status information
=  Web Based User Interface
=  Provides data interface for third party systems over Ethernet
= OPC Server
= ODBC

Power Supply Unit (PSU)

Coordinator and Gateway devices are powered external and small Power
Supply Units (PSU). Each Coordinator and Gateway devices has own PSU,
which contains terminal X1 for mains, X2 for powering the Coordinator or
Gateway device, 5 VDC power supply G1 and main switch S1.

The input for the PSU X1 is 100 — 240 VAC / 50-60 Hz (0.2 — 0.4 A). Use
external fuse or circuit breaker (0.5 A) that is closely located to PSU on the
mains line.

Power cable from the Coordinator or Gateway is connected to terminal X2
which has S5VDC output. Refer also to Appendix 2 for the wiring diagram.

2.2 CellSensor Wireless Network

CellSensor Wireless Network (CWN) is a proprietary network protocol. The
CWN has been developed in order to achieve following objectives:

= Large system scale

= High node density

= High data volume

= Tolerance for very strong magnetic field interference
= High Reliability and scalability

= Low data transfer latency

= Fast and easy set-up

= Sufficient diagnostic information

The CWN is based on IEEE 802.15.4-2006 standard for its robust design on
Physical and Medium Access Control level, as shown in Figure 9. The network

OUTOTEC
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is optimised for the upstream data throughput and network level redundancy is
implemented to achieve reliable data communication.

CellSensor
Application

#

CellSensor

CellSensar Propristary
Metwark Layer

IEEE
802.15.4
PHY & MAC

Figure 9. CellSensor Wireless Network (CWN) Protocol Stack

Personal Area Network (PAN)

CWN is formed by multiple PANs by IEEE 802.15.4 (Personal Area Network).
Each Coordinator or Gateway forms and manages a PAN in CellSensor
network and has communication coverage from tens of meters up to two
hundred meters, depending on the actual environment. Each PAN operates on
one of the 16 channels available in 2.450 GHz ISM Band (see Figure 11).

Data Flow and Routing

OUTOTEC

The CWN is designed and optimised for up-stream data flow to provide reliable
measurement data and with minimum latency time from the CellSensor to
CellSense Server PC.

The main principle of the data flow is presented in the Figure 10 below.
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Figure 10. Data Flow Diagram and Principle of the CellSensor Wireless Network

CellSensor devices can transmit data only with Coordinator devices. Also
Coordinator devices can only send data to Gateway devices. Gateway is
connected with CellSense Server via USB cable (See chapter 2.1.2).

On-power up a CellSensor performs a network scan to search Coordinator
devices in range and associates the one with best radio link quality. The
channel of the Coordinator (PAN) is shown by the LEDs on power up (see
chapter 5.2). If no Coordinator devices are found CellSensor will continue to
scan periodically for Coordinator devices.

If the link with the Coordinator device breaks for some reason (e.g. crane
temporarily blocking the link), the CellSensor will re-scan the network for
alternative Coordinator to transmit the data. Provided that the network layout is
properly designed, meaning that each CellSensor device is able to reach at
least two Coordinators, the network redundancy and robustness for
environmental changes is guaranteed.

From the network perspective, Coordinator devices act similarly than
CellSensor devices. Coordinator devices will associate only with Gateway
devices.

Each device in the CellSensor Network has a unique 16-bit network address,
which is also labelled on the circuit board.

The address and map file of the CellSensor Driver is pre-configured before
installation and shipment, but can be changed later on if necessary. See
chapter 5.3 for instructions on changing the device addresses.
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CellSensor

Every time a CellSensor transmits data it includes its address to the packet. The
address is used by the CellSensor Driver to identify the source of the data at
CellSense Server PC. The driver translates the 16-bit device address into exact
cell location (section, cell) with a map file on the CellSense Server PC. The map
file is a simple text file defining the link between CellSensor device addresses
and their exact location at the cells (see chapter 4.5.2.5 for description of the
map file structure).

CellSensor address consists of four hex value and it is set according to location
of the unit in the tank or cell house. The valid address range is 0100 — EEEE.
The address is labelled on the CellSensor device.

The first two hex values define the section and the last two the cell. In case the
CellSensor is measuring two cells, then the cell address refers either one of the
cells and mapping file is configured to produce two measurements from this
address.

For example, a CellSensor with address 0201 would be located at cell 1 of the
section 2, or OFOA would be located at cell 10 (A) of section 15 (F). If
CellSensor addressed 0201 above was measuring two cells (cell 1 and 2) the
map file includes configuration for the CellSensor Driver to handle the data for
the both cells.

Coordinator and Gateway

Radio Features

OUTOTEC

Although Coordinator and Gateway devices do not produce any measurement
data they have network addresses also. These addresses are required for the
network to operate properly, route the data and for diagnostic purposes. The
network addresses of the Coordinator and Gateway devices are not included in
the map file and they do not incorporate information of the real location at the
tank or cell house.

Coordinators utilize addresses ranging from 0010 to OOFE. The label of the
Coordinator includes CN tag followed by the last two hex values of its network
address (e.g. CN-11, CN-FE, CN-1A).

Gateways address range is 0001 to 000E. The label of the Coordinator includes
GW tag followed by the last two hex values of its network address (e.g. GW-01,
GW-02, GW-0B).

The transmission power of the CellSensor system devices is 0 dBm at
maximum. DSSS (Direct Sequence Spread Spectrum) is utilized on the 2.450
GHz globally unlicensed ISM band (2.400 — 2.483 GHz). The band provides 16
channels for device communications and access is by CSMA/CA method similar
to Wi-Fi systems (Carrier Sense Multiple Access with Collision Avoidance).

Each of the 16 sub channels occupy 3 MHz and are centered 5 MHz from each
other, giving a 2 MHz gap between pairs of channels. The capacity of each sub
channel is 250 kbps. The default network duty cycle of the CellSensor device is
low because of the reporting rules applied for transmission of the data.
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CellSensor device activates the radio only for the duration of the radio
transmission. Coordinator and Gateway devices have their radio always on.

Channel spacing
IEEE 802 154

MAAAARANANAAAA]

nnel 15 Channel 20 Channels 25, 26

2405 MHz 3 MHz

. 25 MHI ey

IEEE.302:1} Channel spacing

NN

22 MHz

2412 MHz 2425 MHz 2437 MHz 2450 MHz 2462 MHz 2475 2480
MHz MHz

Figure 11. The 16 sub channels of IEEE 802.15.4 and Wi-Fi (802.11) channels
used in North Americas.

Coexistence with Wi-Fi Networks (802.11)

OUTOTEC

Since the 2.450 GHz ISM band is globally available for many other wireless
devices and systems, such as Wi-Fi, co-operation, -existence and robustness of
these systems is considered in the CellSensor system design and also by IEEE
802.15.4.

As CellSensor can utilize varying selection of channels available and is a low
duty cycle system with very low transmission power, CellSensor system can be
well configured to guarantee un-interrupted and reliable data transmission and
also low inference for other systems.

For instance, as shown in lower part of Figure 11, the Wi-Fi systems operate
typically one of the three wide channels allocated for them by 802.11 on 2.450
GHz band. Therefore, a set of channels can be determined for the CellSensor
system components that do not over lap the Wi-Fi channel used. There are
always few channels available that are not used by Wi-Fi at all (15, 20, 25 and
26 for typical Noth American Wi-Fi systems (802.11b)).
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3. Operating Safety

Before installing, operating or maintaining the CellSensor System please
familiarize yourself with these important safety and operating instructions
described in this section. By following these instructions you enable full
utilization of the system, prevent unnecessary equipment malfunctions and
most importantly provide safety for the users working with the system and its
components.

Warning sign presented below on any of the system component requires
special attention on safe operating of the component and system.
Following the instructions of the manual is strictly required.

Failure in following these instructions may lead serious personal injury,
damage of the equipment and avoid warranty!

General instructions:

= Only trained and authorized persons are allowed to install, operate and
maintain the system components

= All the work, materials and design applied for the system components must
comply the effective local regulations, safety rules and procedures that

may apply

= The permitted actions for operating and maintaining the CellSensor system
are specifically described in this manual. Never try to open, remove or
modify any other parts or components from the system, or use the system
components against the instructions. The instructions cover only the
normal use of the system components.

= Do not unnecessarily make any change to device settings. These settings
are critical to system performance, safety and functionality. Consult
Outotec support in any concerns before any configuration changes.

= Make sure you know how to power down the components in case of
emergency (see chapter 5) or whenever necessary

= Do not replace any component or part of the system with a component or
spare part not approved by Outotec.

= Make sure that system component is powered down before any
maintenance is performed to the components

= Do not connect any other devices, wires, voltage/current or equipment than
what is specified and described in this manual to the input terminals of the
system components.

= Do not use any of the system components if it has sustained or there is
reason to suspect for any type of damage

OUTOTEC
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= Mount the devices and route all the cables in such a way that no safety risk
is caused for the operators or other persons at the plant.

= Do not connect any other communication cable than what has been
supplied with the system to the J3 port pins (Gateway device)! Use only the
pins, signals and signal levels described in the appendix 3. See Appendix 3
for port and port specification.

If you are in doubt of safety of the equipment, switch off the electric power
and report your findings immediately!

3.1 Electrical Safety

OUTOTEC

The CellSensor system fulfils the Low Voltage Directive (LVD) and other
relevant European Union safety regulations.

The CellSensor is electrically floating between the cell bus bars and the
potentials of bus bars are connected with short wires to CellSensor terminal T1.
The voltage level inside the CellSensor box and on terminals of T1 are
determined by the input voltage, which equals the cell voltage. The input
voltage level depends on the type, configuration and design of the electrolytic
cell and produced metal. Typical cell voltages range from 0.3 to 0.6 V in copper
refineries and from 1.2 to 3.9 V in different electro-winning plants.

The normal operating range for CellSensor input voltage is 0.16 — 4.0 V (voltage
booster operating area). Because each CellSensor is capable of measuring two
cells, the normal operating voltage levels inside the CellSensor box are
between 0.16 — 8.0 V. The voltage level of microprocessor circuitry is always
3.3 V.

The normal current draw of CellSensor is 0.010 — 0.200 A depending on the
input voltage. If a CellSensor device has been in power-saving mode for a long
time and battery has depleted to low levels, the current draw can temporarily
increase to 0.2 — 2.0 A for the duration of re-charge.

Depending on the electrical connections and layout between electrolytic cells
the input voltage can temporarily increase over normal values e.g. during
cathode harvests or cell maintenance. Always find out and be aware of the
possibility of having exceptionally high cell voltage levels present before
opening the CellSensor box cover.

As the cells are electrically connected in series, the potential of a cell bus bar
can be high to plant grounding (even 700 V). Follow carefully the local safety
regulations and minimize the length of the bus bar wires to prevent possibility
for short circuited connection to the grounding due to lose wire or some other
improbable event or accident.

The nominal voltage of the mains power supply for PSUs of Coordinator and
Gateway devices and CellSense Server PC is 115 or 230 VAC. The mains
voltage is connected to external PSU (Power Supply Unit) of Gateway and
Coordinator devices. The voltage between the PSU and Coordinator/Gateway
box is 5 VDC.
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Bus Bar Wires

A huge electrical current is passing through each electrolytic cell and bus bars
(typically 17 000 — 40 000 A).

= Always apply extra caution and care when working with bus bar wires

= Do not let the wires that are connected to different bus bars connect to
each other (short circuit) in any circumstances

= Do not touch or disconnect the wires of terminal T1 before making
sure that they ALL have been disconnected from the bus bars first!

= Always connect the wires to terminal T1 before connecting them to bus
bars. Make sure that the wire is tightly and properly connected to T1 and it
is not short circuited with other terminals of T1 or T2

Short circuiting the bus bar wires may lead to serious personal injury,
equipment damage or fire.

3.2 Battery Safety

OUTOTEC

Each CellSensor device includes a re-chargeable Li-lon back-up battery unit
(Panasonic CGR18650CF1S1P with Fey GmbH safety circuit, 3.6V / 2350
mAbh).

= The CellSensor is carefully designed and tested to use the battery
supplied with CellSensor device

DO NOT REPLACE OR USE ANY OTHER BATTERY WITH THE
DEVICE!

= |n case the battery needs to be replaced with a valid spare battery, follow
the instructions of chapter 6.1 and 6.4 tightly

= Connect the battery only to designated connector (J5) on board.

= The battery plug can be connected to connector J5 only in one way. Do not
use extra force to plug in the battery.

= Do not connect any other power source to J5 connector of CellSensor
Device than the battery, that was supplied with the device or as a spare.

= The maximum operating temperature of the battery is 60 °C. If the ambient
temperature increases above this limit, disconnect the battery.

= Do not deform, puncture, short circuit, disassemble or modify the battery
= Do not alter the battery for water or any other liquid

= Do not heat the battery or throw it into fire

= Do not leave the battery in high temperatures. Store it under 40 °C.

= Do not subject the battery to strong impact or throw it

The battery is equipped with an integrated and approved protection circuit to
prevent under or over voltage and provide protection for short circuit condition
of the battery wires. The advanced battery loading algorithm on board takes
care of the automatic and safe charging of the battery in proper operating
conditions (ambient temperature).
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4. Installation

4.1 Main Principles of Installation

Each CellSensor system is designed to match the layout of the electro-refinery
and to guarantee best performance through optimised structure of the system.
The CellSensor system is designed, configured and tested before shipment to
the site (addressing, scan rates, voltage ranges, etc.).

The CellSensors include the bus bar cables readily attached to terminal T1 of
CellSensor (2 m / bus bar). The bus bar end of the cable is un-finished and
must be prepared during the installation to suit the tapping method used.
Coordinator and Gateway devices include the external PSU (Power Supply
Units) boxes with internal cabling (5 VDC supply from PSU to device).

The operation of wireless devices starts automatically when the devices are
powered on. All the software is loaded on the CellSense Server PC hard disk
with initial configuration.

Usually the CellSense Server PC requires some changes and fine tuning in
software parameters and server settings after first power-up (IP addressing,
user names and privileges, domain settings, etc.).

Location of System Components

CellSensor

OUTOTEC

CellSensor devices are attached to the electrolytic cell. The design, space
availability and layout of electro-refining cells vary from plant to plant, so the
strategy of mounting the CellSensor device to a cell must be designed and
agreed separately.

CellSensor device provides two standard options for mounting. A hook bracket
to mount the device by hanging it over the cell edge or a set of holes on the
back-plate for screw or tap based mounting to the cell wall.

CellSensor can also be mounted to some structure close to cell or even to the
basement. In such case special attention needs to be paid on the electrical
safety between bus bars and grounding of the electro-refinery (see chapter 3 for
safety instructions).

Normal mounting orientation of CellSensor device is:
= Back plate facing to the cell

= Cabile fittings facing down and roof cover facing up
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Figure 12. A CellSensor Mounted and Wired Properly to the Cell. Wiring Case
for an EW Cell displayed, see other wiring options from Appendix 2.

Coordinator, Gateway and PSU

OUTOTEC

Coordinator and Gateway devices and their PSUs (Power Supply Unit) should
be located on open space on the walls of the tank or cell house in such a way
that they are easy to connect to mains and that their radio coverage is good.

The clearance between a Coordinator or Gateway and wall should be more
than 0.3 m to guarantee good radio signal (See chapter 4.4 for mounting of
Coordinator devices)

Non-hindrance to moving cranes of other equipment or work performed on the
cells must be considered.

The mains power of a Coordinator or Gateway (110/230 VAC) is connected to
PSU terminal X1. The mains power line should be fused (0.5 A) or equipped
with an external circuit breaker. There is a 10 meter internal power cable
between PSU and Coordinator device (5 VDC), which can be extended if
required. Therefore, PSU can be located in different location than Coordinator,
e.g. closer to electric supplies and places for more convenient access for
switching on/off the Coordinator devices.

Gateway devices should be centrally located to Coordinators to minimize the
routing of measurement data. They should also be close to CellSense Server
PC for USB or Ethernet connection (USB connection can be extended by
suitable converters if necessary).
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CellSense Server PC

Required Tools

The CellSense Server PC should be located in clean and conditioned room with
access to plant Ethernet network and connection to Gateway devices.

The basic installation of CellSensor system components does not require
special tools or devices. A basic set of normal plant maintenance and
instrumentation tools like pliers, side cutters, adjustable spanners, screw
drivers, pipe bending tool, welding machine and hand drill are enough to mount
and start-up of devices.

Usage of standard multimeter device (e.g. Fluke) is also recommended in
certain steps of the installation.

4.2 Steps of Installation

4.3 Preparation

Bus Bar Wiring

OUTOTEC

The main steps and order of installation are:

1.
2,

Unpacking of the system components

Preparation of CellSensor devices

—  Bus bar connection

— Bus bar cables

— Installation of any assisting mounting accessories (plates, hooks,
holes, etc)

Preparation of Coordinator and Gateway devices

— Attachment of mounting rack

—  Power distribution

— Installation of communication cable between Gateway and CellSense
Server PC

Preparation of Temperature Probes
— Bending of Probes to suit cell design
—  Connection of probe wires to CellSensor device

Mounting and power up of Coordinators and Gateways
Mounting and power up of CellSensors

Installation of CellSense Server PC, license module and final configuration

There are many options to connect CellSensor bus bar wires to bus bars.

The most common, easy and low cost method is to tap the cable with screw to
the end of a bus bar. The main steps of preparing this type of connection is
generally described in this section.
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Figure 13. Bus Bar Tap with Screw.

1. Dirill holes to the bus bars and prepare threads matching the screws used
to tap the cable

— Use only stainless steel screws (AlSI316) for tap connections

— Connect bus bars wires only to main bus bars in Outotec
DoubleContact™ bus bar systems

2. Cut the bus bar cables of CellSensor to adequate length
— The bus cable type is 4 mm* (AWG 12) copper (PVC)
— Each cable should reach well the bus bar connection point

Route cables in such a way that no safety risk is caused for the
operators.

Each cable should have a route that causes minimum disturbance for
the operators and are least vulnerable for damage

Make sure that if cable gets accidentally loose or is cut, it will not have a
chance to get short circuited to plant grounding

Do not coil the cable between the bus bar and CellSensor

3. Prepare the cable terminals
— Clamp the suitable terminals to the bus bar wires for screw mounting

The contact between the electrical wire and the bus bar is susceptible to
deterioration. The CellSensor utilizes its on-board computation power to identify
and alarm the bad tap contacts for on-demand fix of the loose tap contacts.

Installation of Mounting Accessories

Depending on the mounting method chosen, prepare and mount the extra
assisting equipment, like back-plates for screw based mounting, holes for the
screws, supporting frames, etc. to the cell.

In case hook bracket is utilized, attach hooks to the back-plates of the
CellSensor devices. Place the bracket to the back plate in a way that the holes
of the bracket match the wings of the back plate. Tighten the brackets by
bending the small attaching steel wings with pliers.

OUTOTEC
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Temperature Probe

OUTOTEC

Temperature probe is shipped as a one meter straight probe. Because the
designs of electrolytic cells are different from refinery to refinery and locations
suitable for the probe placement vary, the final forming is done at site before
commissioning.

The forming, or bending, of the probe is done with a standard tube bending tool
used e.g. for preparing instrumentation air pipe lines. The diameter of the
temperature probe is 6 mm.

1. Design the mounting location and method, e.g.
— Hanging around cell overflow edge

— Utilizing an external support for mounting

2. Measure and mark the places where the probe needs to be bend and also
the amount (angle) of bending required. Use coloured marker.

3. Bend probes according to markings with tube bending tool (6 mm pipe).
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4. Pass the probe wires through the rightmost cable fitting. Use soft electric
tape or similar to tie the wires firmly together from 5-8 cm wire ends.
Locate the tape area to fitting when passing the wires through.

TAPE LOCATION

LABEL FOR PROBE 1

5. Remove the terminal T2 plug and connect the probe wires to the T2
terminals (refer also to Appendix 2 and project documents for correct
wiring)

—  Blue wire either to D1 (probe 1) or D2 (probe 2)
—  Brown wire to GND next to terminal where Blue wire is connected

— Note. Label the probe wire connected to D1 (probe 1). This helps in
placing the probes correctly to cells during mounting of the devices.

OUTOTEC
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6. Connect the terminal T2 plug to the header

N

7. Tighten the cable fitting properly and test that the fitting seals the
cabinet properly in order to avoid damages due to e.g. condensate

The probe can also be attached to T2 terminal during the mounting of the
CellSensor devices at the cells. See also Table 2 of chapter 2.1 for Terminal 2
Description.

Note. It is beneficial to consider a light plastic tube or steel U-bar around the
probe in the areas where it might be subject for mechanical damage (e.g. due to
cranes, movable pumping stations, etc.).

Power Distribution and Racks for Coordinators and Gateways

OUTOTEC

Coordinator and Gateway devices operate on external 110/230 VAC power,
because they are located high on the refinery walls. Standard mains power
needs to be supplied to the designed mounting spots of the PSU units of these
devices. Use external fuse (0.5 A) or circuit breakers in mains line supplying the
PSU, which should be closely located (recommendation).

Design the routes for the internal power cables between PSUs and their
Coordinator or Gateway devices.

Also light mounting racks need to be prepared to mount the devices to walls
and to provide at least 0.3 meter clearance from the wall. This is to guarantee
good radio performance for these devices. Utilize suitable plastic material (e.g.
polypropylene) for the environment or AlS1316 for the mounting racks.

Attach Coordinator and Gateway devices to the racks.
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Some example mounting racks are shown in the Figures 7 and 8 of chapter 2.1.

Communication Cable between Gateway and Server PC

Prepare and mount the USB cable connecting the Gateway and CellSense
Server PC according to local standards. Connect the USB cable to any free
USB port of the CellSense Server.

4.4 Mounting of Devices

CellSensor

Coordinator

OUTOTEC

Once the system components are prepared according to instructions of chapter
4.3 they are ready to be mounted. If possible, the Coordinator and Gateway
devices should be mounted and powered up first.

Mounting of the CellSensor device is done according to following procedure:

1.
2,

Open the CellSensor box

IMPORTANT! Connect the battery plug to battery connector (J5) and wait
that LEDs flash twice. Disconnect the battery. This step is to guarantee that
CellSensor device is in proper and safe state before it is attached to the
cell.

Connect to bus bar wires to bus bars. Make sure that the wires are
connected in right order to bus bars (see Appendix 2 and your project
documentation). The black coloured wire must be connected to lowest
potential bus bar. Refer also the cable routing instructions presented in
chapter 4.3.1.

Mount the CellSensor device to cell

Place temperature probes to cells. Make sure that the probes are placed in
right order to the cells (utilize the label described in the chapter 4.3.3,
Appendix 2 and your project documentation)

Check that voltages are according to wiring plan on T1 terminals by
measuring with a multimeter device (e.g. Fluke)

Connect the battery to battery plug J5

Wait and monitor CellSensor to power up (~5 seconds) with information
provided by the LEDs. See chapter 5.2.1 for more detailed information on
the LEDs.

Close the CellSensor box

Mounting of the Coordinator device is done according to following procedure:

1.
2,

Mount the Coordinator and PSU to designed places

Open the PSU box and make sure that PSU main switch is in OFF (0)
position.
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3. Mount and route the internal power cable emerging from the Coordinator.
Pass the cable through the right-hand cable fitting and tighten it properly.
Connect the cable wires to PSU terminals 3 and 4 of X2. See Appendix 2
for wiring diagram.

4. Pass the mains cable through the left-hand cable fitting and tighten it
properly. Connect the mains cable wires to PSU terminals 1 and 2 of X1.

Switch the power ON (1) with the PSU mains switch
Close the PSU box

Gateway
Mounting of the Gateway device is done according to following procedure:
1. Mount the Gateway and PSU to designed places
2. Open the PSU box and make sure that PSU main switch is in OFF (0)
position.
3.  Mount and route the internal power cable emerging from the Coordinator.
Pass the cable through the right-hand cable fitting and tighten it properly.
Connect the cable wires to PSU terminals 3 and 4 of X2. See Appendix 2
for wiring diagram.
4. Pass the mains cable through the left-hand cable fitting and tighten it
properly. Connect the mains cable wires to PSU terminals 1 and 2 of X1.
5. Mount, extend if necessary and connect the USB cable emerging from the
Gateway unit to a free USB port of the CellSense Server PC
6. Connect the mains power to PSU terminal X1
Switch the power ON (1) with the PSU mains switch
8. Close the PSU box
Server PC

The CellSense Server PC should be mounted to clean and air conditioned room
with UPS electric supply and plant Ethernet connection available. Optimally the
PC should be close to Gateway device for USB connection, but can be
extended by utilization of suitable signal converter devices available (See also
chapter 2.1.3.1).

4.5 Configuration of Software

CellSensor system incorporates few licensed software components on the
CellSense Server PC. All software is installed, pre-configured and tested before
shipment, commissioning and start-up of the CellSensor system.

= CellSensor Driver — Reads the data from the Gateway over USB or
Ethernet (virtual COM port) and provides it for the CellSense user
interface. Driver provides also OPC Server and ODBC interfaces for third
party system communications (e.g. Historians and DCS systems).

= CellSense Monitoring System — Provides a real time and web based
monitoring view for easy access to CellSensor measurement data. The

OUTOTEC
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USB License Module

system performs also advanced data processing to display the cell status
information instead of plain measurement values. Please refer to
CellSense manual for more information.

All software components require a license to run, which is contained in a USB
module. The existence of the license is periodically monitored by the software.
Do not remove the license module when CellSensor or CellSense software is
running.

The license specifies the scope of electrolytic cell data it can handle with the
software and options enabled for the system. The scope of the license is always
logged to the driver log file ([CellSense folder]\log) on CellSensor Driver start up
and defined in your CellSense and CellSensor License Agreement.

In case more CellSensors are transmitting data than the license entitles, the
CellSensor Driver will stop and log license violation to the log file. In such an
event decrease the number of CellSensors in the system or contact Outotec
support.

Installation of the License Module

OUTOTEC

The license is shipped as an USB module shown in Figure 13. The attached
label contains important information about the license (serial and key number
and customer identification).

Drivers for the USB license module are installed automatically during the
CellSensor Driver setup.

Figure 13. USB License Module with License Information Plate. Have the
Module always in USB port of the CellSense Server PC while the CellSensor
Driver or CellSense software is running.
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CellSensor Driver

Installation

To install the CellSensor Driver:

1. Insert the CellSense Installation CD to PC and run X:\Software\CellSensor\
CellSensor Driver v[version number].exe
(X is the drive letter of the CD or DVD drive of the PC, it can vary
depending on the PC settings).

2. Windows Installer starts to install the driver. Click Next.

i'._% Outotec CellSensor Driver - InstallShield Wizard il

Welcome to the InstallShield Wizard for
Outotec CellSensor Driver

The InstalishieldiR) wizard will install Qutotec Cellsensar Driver
on your computer, To continue, click Mext,

WARMING: This program is protected by copyright law and
inkernational treaties,

= Back I Mext = I Cancel

OUTOTEC
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3. Select the parts to be installed, click next.

{ii Dutotec CellSensor Driver - InstallShield Wizard

Custom Setup

Select the program Features vou want installed.

Click on an icon in the list below to change how a feature is installed.

mREeature Descrigkicn

Install configuration File
examples.

= ~ | Driver
= ~ | Config files

This feature reguires 16KE on
wour hard drive,

Install to:

C:YProgram FilestQutotechCellSensariDriver), Change... |
ImstallShield
Help Space < Back I Mext = I Cancel |

4. Click Install

i'.fﬂ Outotec CellSensor Driver - InstallShield Wizard

Ready to Install the Program

The wizard is ready to begin installation,

IF wou want to review of change any of vour installation settings, click Back. Click Cancel ko
exit the wizard,

Current Settings:

Setup Tvpe:

Destination Folder:

:\Program FilesyoutotecZellSensori Driver!

User Information:
Mame: Shared IT Services

Company: Qutokumpu Oy

Imstallshield

< Back I Install I Cancel |

5. Wait Installer to install the Driver. Click Finish (This takes a while as USB
module drivers are installed now).

OUTOTEC
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i'-.‘!rl' Outotec CellSensor Driver - InstallShield Wizard

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Outotec
Cellsensor Driver, Click Finish to exit the wizard,

x|

= Back I Finish I

Zancel

6. Open Command Prompt to configure the driver. Start > Run... - cmd and
click OK.

7. Browse c.\Program Files\Outotec\CellSensor\Driver\

8. Make sure that USB license module is in the USB port

9. Type CellSensorDriver.exe —help

10. Follow the instructions displayed for finishing the installation.

Outotec CellSensor Driver Help

\El)

Command line parameters;
-help  This help.

-inskall  Install Windows service,
-uninskall Uninstall Windows service,

Tao Install:
1. Edit canfig. xml
2, Run with -inskall

3, Start 'CellSensor Driver' from Windows Services,

To UnInstall:
1. Stop 'CellSensor Driver' From Windows Services.
3. Run with -uninstall

X

Found -help, other command line parameters ignored,

COM Port

CellSensor Driver reads the data from the Gateway device over COM port to
which the communication cable is connected. The COM port number and
parameters are defined in the driver configuration file (see chapter 4.5.2.2). In
case CellSensor system consists two Gateways, they have own COM ports for
communications.

OUTOTEC
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If default USB cable connection is used between Gateway device and
CellSense Server PC, the virtual COM port is created automatically during the
Driver installation. The COM port numbers and properties can be checked from
Start > Settings > Control Panel - Administrative Tools > Computer
Management as seen in the Figure 14 below (COMS).

=]
Q File —Action ‘“iew ‘Window Help | =1
- EESFE R Axna
@ Computer Management {Local) =] E'_ ESPLT451

; P\‘g Batteries

_.? Compuker

age Disk drives

§ Display adapters

i DVDJCD-ROM drives
i) Floppy disk controllers

- m System Tools
I @ Ewent Wigwer

Shared Folders

Local Users and Groups
Performance Logs and Alerts
2 Device Manager

= @ Starage @8 Human Interface Devices
- Removable Storage - IDE ATAJATAPT controllers
= Disk Defragmenter % Infrared devices
Disk Management 2 Keyboards

[]--@ Services and Applications ) Mice and other painting devices

L Modems

3 Manitars

ﬂ Metwork adapters

-8 PCMCIA adapters

= ry Potts (COM & LPT)

; # Communications Pork (COMZ)
r;yi Printer Port {LP
(;yi USE Serial Port
Processors

@, sound, viden and game contrallers

é System devices

[-8¥ Universal Serial Bus controllers

1 |2
| | |

Figure 14. COM Ports of the CellSense Server PC can be checked and
modified with Computer Management Console.

If RS232 connection is used then the serial COM port number is used by the
Driver.

If Serial to Ethernet converter is used between the Gateway device and
CellSense Server PC then the setup utility of the converter device needs to be
run and virtual COM port installed. The CellSensor driver will communicate with
this virtual COM port over Ethernet to the Gateway.

Configuration of the Driver

OUTOTEC

CellSensor Driver requires some parameters to run properly. These parameters
are set in the C:\Program Files\Outotec\CellSensor\Driver\config.xml file and
can be edited with Notepad editor for instance. Driver reads the configuration
file on start-up, so any changes applied to the file requires re-start of the Driver
(see chapter 5.1.3). The configuration file is configured and tested before the
shipment and commissioning.

The configuration file structure is shown in the Figure 15 below. Description of
the parameters are provided in the Table 5.



User Manual

Code CSS-001

Revision 1.04 Page 39 (72)

OUTOTEC

; N:\3 TECH\Development Projects’ Tankhouse' CR-050028_CellSensor’temp - Files older than a day cal - E||5|

Eile Edit Miew Favorites Tools  Help ‘ l';.

GEGEK"J'IJ@ ;\J ENE ‘ii

fiddress [ u:|3 TECH|Development Projects)Tankhouse)CR-050028_Cellsensoritemp - Fies oider than = | [ @0 | Links >*

—~ n
) o) LY
7 Search S Favorites {(

Coogle | C~ d+ () Asstuksetw

<Tuml version="1.0" 7>

<l-- If a filename/path have character ':', then it is asbsolute path, else path is relative to
application runpsath. —-—>
.
csloglevellisablelogging = -1
csloglevelInternal = O
csloglevelFailure = 1

csloglevelCritical = 2
csloglevelllarning = 3
csloglevelInfo = 4
csloglevellbebuy = 5
>
- <iCellSensorDriver TYPE="CellSensor Driver" version="0.4" LogLevel_File="5" LogLevel_SystemEvent="1"
MapFileName="map.csv" Last'/aluesFileName="lastvalues.dat" csvSeparator="," TemperaturesareCelsius="TRUE"
Use0OPC="true" OpcToplpPort="706" OpcTagTimeoutSeconds="120" BatteryLowYoltage="3.65"
SensorCommunicationTimeoutSeconds="120">
- <Gateways>
<Gateway Name="GW1" Address="0001" Coordinatorsddress_Min="0010" Coordinatoraddress_Max="001F"
Port="COM3" PortSettings="57600,n,8,1" CommunicationTimeoutSeconds="240" RawDataLogFileName="" />
«l-- GWlraw.txt -->
</Gateways>
- 50l
<S0L Mame="8QL1"
ConnectionString="Provider=SQLOLEDB;Server=ESPDT457;Database=C5_80URCE;Uid=CSwriter;pwd=write;"
ConnectionTimeout="2" CommandTimeout="2" BufferPath="8QL1Buffer" /=
“/S0Lss
=/CellSensorDrivers

' i

EED CT T T T Mo

Figure 15. The configuration file of the CellSensor Driver (config.xml)

Table 5. Description of the CellSensor Driver Configuration Parameters

Parameter Description

Value / Type

TYPE

Internal parameter
Do not change

“CellSensor Driver”

Version Version Number Version number (real)
Internal parameter
Do not change

LogLevel_File Logging Level 0,1,2,3,4,5
(description of the default: 3

levels in the file)

LoglLevel SystemEvent

Logging Level to
System Log
(description of the
levels in the file)

0,1,2,3,4,5
default: 1

MapFileName

Name of the Map File

Must correspond the
map file name

“[map file name]”
default; “map.csv”

LastValuesFileName

Internal parameter
Do not change

“lastvalues.dat”

csvSeparator

Separator used in csv

files

TemperaturesAreCelsius

Temperature Units

“TRUE” - Celsius
“FALSE” - Fahrenheit

UseOPC

OPC Server in use

“TRUE” - enabled
“FALSE” - disabled
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BatteryVoltageLow Low Warning Limit for 3.0 -3.9 (real)
Battery default: 3.65

OUTOTEC

SensorCommTimeOut*

Timeout for no data
from a CellSensor.
CommunicationLink
alarm is raised if no
data is received during
the timeout interval. In
seconds.

default 120 (integer)

Name Descriptive name for “[Gateway name]”
the Gateway. default “GW1”
Information only. If two
Gateways are
configured, names
must be different

Address Gateway network 0001-000E
address (hex, 16-bit)
(See the label on the
Gateway)

CoordinatorAddress_Min  Smallest Coordinator 0010-00FE
network address (hex 16-b|t)
allowed in the system ’

CoordinatorAddress_Max Highet Coordinator 0010-00FE
network address (hex 16-b|t)

allowed in the system

Port COM Port (virtual or “COM[COM Port
real depending whether Number]’
USB/SerlaI/E_thernet IS default: “COM3”
used) for which the
Gateway is connected

PortSettings COM Port Settings “[baudrate],
Wil be set to the cOM  [Parityl,
port on Driver start up.  [data bits],

[stop bits]

default: “57600,n,8,1”

CommTimeOut*

Timeout for no data
from Gateway in
seconds. Driver re-
starts on timeout. In
seconds.

default 240 (integer)

RawDatalLogFileName

Internal parameter
Do not change

“[Name]datalog.dat”

SQLName

Descriptive Name for
SQL Connection.
Information only.

“ISQL Connection
Name]”

default: “SQL1”

ConnectionString

SQL Connection String
describing the SQL
access.

See Figure 16 for an
example.
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ConnectionTimeOut SQL timeout (connect)  default: 60 (integer)
in seconds
CommandTimeOut SQL command timeout  default: 60 (integer)
(queries, etc.) in
seconds
BufferPath Internal parameter “[SQLName]buffer”

Do not change or
modify the content

*Abbreviated

Enabling / Disabling OPC Server

Map File

To enable and disable the OPC Server interface:
1. Stop the CellSensor Driver. See chapter 5.2.3.2 for instructions.
2. Open Notepad Start > Run... > Type Notepad and click OK

3. Select File > Open... and browse
C:\Program Files\Outotec\CellSensor\Driver\config.xml = Open

Find parameter useOPC

Change value FALSE to TRUE if you want to enable the interface.
Change value TRUE to FALSE if you want to disable the interface.

Do not edit anything else in the file!
6. Save the file. File > Save.

Close the file

8. Start the CellSensor Driver. See chapter 5.2.3.1 for instructions.

OUTOTEC

Map file links the CellSensor network addresses with the cell or cells that each
CellSensor device is measuring (see chapter 2.2.3). It also contains the OPC
tags that are created for the OPC Server on CellSensor Driver start-up for each
CellSensor measurement. The OPC tags can be freely edited with the map file,
but it is important to adhere the OPC standard (http://www.opcfoundation.org).
See chapter 7.2 for the default tag names used for CellSensor measurements
and diagnostics.

Driver reads the map file on start-up, so any changes applied to the file requires
re-start of the Driver (see chapter 5.1.3). The map file is configured and tested
before the shipment and commissioning.



User Manual

Code CSS-001

Revision 1.04 Page 42 (72)

CellSensor

Data from CellSensars (USB/Serial/Etherneat). 1 Driver
Data contains CellSensor netwoark addresses .
to identify the source of the measurements.

Cluery: Retum:
Metwork address Cell and Section nurmbers
OPC tags for data

blap File describes the link between

the CellSensor network address and
cells where the CellSensor is measuring
the data. It also contains the OPC tags
for measurement data.

Map File

Imap.csy)

Figure 16. The Principle of the Map File in Data Flow

Map file is a simple csv (comma separated file) file residing at C:\Program
Files\Outotec\CellSensor\Driver folder.

Each line of the file describes one CellSensor device, so there is one line for
each CellSensor in the system in the map file.

The parameters of a line of the file describing one CellSensor device are shown
in the Table 6 below.

Table 6. Description of a Single Line (a CellSensor) of the Map File Parameters

Index Description Value / Type

1 CellSensor Network Address 0100 — EEEE
Labelled on the CellSensor (hex, 16 bit)

2 Section Number Integer

3 Cell Number 1. Integer
See Appendix 2 for wiring options. This
number is for cell where temperature probe 1
is located.

4 Sensor Number 1 = First Sensor
In case more than one CellSensor are (e.g. on overflow
installed to a cell, Sensor Number is used to ~ Sid€)
identify different sensors located in the same 2 = Second Sensor
cell. (e.g. on feed side)

(Integer)

5 Cell Number 2. Integer

See Appendix 2 for wiring options. This
number is for cell where temperature probe 2
is located.

OUTOTEC
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6 Sensor Number 1 = First Sensor
In case more than one CellSensor are (e.g. on overflow
installed to a cell, Sensor Number is used to ~ Si9€)
identify different sensors located in the same 2 = Second Sensor
cell. (e.g. on feed side)

(Integer)
7 Not in use (reserved for future)
8 Not in use (reserved for future)
9 OPC Tag for Cell Number 1 Voltage [OPC Tag Name]
(String)

10 OPC Tag for Cell Number 1 Temperature [OPC Tag Name]
(String)

11 OPC Tag for Cell Number 2 Voltage [OPC Tag Name]
(String)

12 OPC Tag for Cell Number 2 Temperature [OPC Tag Name]
(String)

13 Not in use (reserved for future)

14 Not in use (reserved for future)

15 OPC Tag for Communication Link [OPC Tag Name]
Diagnostics (String)

16 OPC Tag for Battery Voltage Diagnostics [OPC Tag Name]

(String)

17 OPC Tag for Battery Low Warning [OPC Tag Name]
Diagnostics (String)

18 OPC Tag for Cell Number 1 Bad Tap Contact [OPC Tag Name]
Quality Status Warning Diagnostics (String)

19 OPC Tag for Cell Number 2 Bad Tap Contact [OPC Tag Name]
Quality Status Warning Diagnostics (String)

20 OPC Tag for CellSensor Ambient [OPC Tag Name]

Temperature Diagnostics

(String)

Note. If parameter value is 0 for index 3-6, then the measurement values for the
item are not stored to SQL Server. If the parameter value for index 2 (Section
Number) is 0 then none of the measurements for the CellSensor are written to
SQL Server. This has no effect on the OPC Server. The value are written to
OPC Server normally, provided that OPC Server is enabled.

OUTOTEC
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OPC Server

Installation

To install the OPC Server for CellSensor Driver:

1. Insert the CellSense Installation CD to PC and run X:\Software\CellSensor\
CellSensor OPC Server v[version number].exe
(X is the drive letter of the CD or DVD drive of the PC, it can vary
depending on the PC settings).

2. Windows Installer starts to install the driver. Click Next.
{i& Dutotec CellSensor OPC Server - InstallShield Wizard x|

Welcome to the InstallShield Wizard for
Outotec CellSensor OPC Server

The InstallShield{R) Wizard will install Outotec CellSensor OPC
Server on your computer, To continue, click Mext,

WARMING: This program is prokected by copyright law and
international treaties,

= Back

Cancel |

3. Click Install wait OPC Server to be installed.

OUTOTEC
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{% Dutotec Cellsensor OPC Server - InstallShield Wizard

Ready to Install the Program

The wizard is ready to beqin installation.

If wou want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard,

Current Settings:

Setup Type:

Destination Folder:
C:\Program FilesiOutatecCellSensoriOPC Server),

User Information:
Mame: Shared IT Services

Company: Cutokumpu Owj

ImsballShield

T Cancel

< Back

Click Finish (Installation is ready)

Open Command Prompt to configure OPC Server. Start > Run... > cmd
and click OK.

6. Browse c.\Program Files\Outotec\CellSensor\OPC Server\

Type CellSensorOPCServer.exe regserver to register the OPC Server

Cellsensor DPC Serye x|

" | J OPC server registered,

OUTOTEC
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5. Operating the System

Read the safety instructions of chapter 3 carefully through before operating
system.

5.1 Starting and Stopping of the System Components

CellSensor
Power Up
Open the CellSensor box
2. Connect the battery to battery plug J5
Wait and monitor CellSensor to power up (~5 seconds). The progess of the
start-up sequence is shown by the LEDs. See chapter 5.2.1 for more
detailed information on the LEDs.
4. Close the CellSensor box
Reset

Open the CellSensor box

2. Push Reset button on the CellSensor PCB board (middle and on top of the
T1 and T2 terminals)

3. Wait and monitor CellSensor to power up (~5 seconds). The progress of
the start-up sequence is shown by the LEDs. See chapter 5.2.1 for more
detailed information on the LEDs.

4. Close the CellSensor box

Power Down

Open the CellSensor box

2. Push Reset button on the CellSensor PCB board (middle and on top of the
T1 and T2 terminals).

Disconnect the battery from the battery plug J5

4. Close the CellSensor box

Start up Sequence

On start-up, CellSensor goes through a chain of procedures to initialise the
device. The progress of the sequence is informed by the LEDs on board. The
normal start-up time is approximately 5 seconds.

OUTOTEC
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On power up all LEDs flash twice, after which yellow LED is visible for the
duration of the network scan for Coordinator devices. If a Coordinator is found,
its channel is informed by the LEDs as a 4 bit number (each LED represents a
bit). See chapter 5.2.2 Table 4 for more detailed information.

After successful network scan, CellSensor will enter power saving mode until
the cell voltage has been in normal range for a buffer time period (see 2.1.1.2).

In case no Coordinator is found, CellSensor will enter Power Saving Mode (all
LEDs off). CellSensor will perform frequent re-scan of the network automatically
(yellow LED visible) and also check the input voltage level (green LED flashes
once).

Coordinator and Gateway

Power Up

Power Down

1. Open the PSU box
2. Switch the mains switch to ON (1) position
Close the PSU box

CellSensor Driver

OUTOTEC

1. Open the PSU box
Switch the mains switch to OFF (0) position
Close the PSU box

Be always aware of the effects of powering down Coordinator or Gateway
devices.

Powering down of the Coordinator forces all associated CellSensors to switch
automatically to another Coordinator in the range. Therefore, it will have no
effect on the data flow, in case another Coordinator can be located and it has
capacity to handle the new CellSensors.

The location of the Coordinators should always be designed so that every
CellSensor is able to reach at least two Coordinators well. The more a
CellSensor is able to reach the more redundant and reliable the system is.

Powering down a Gateway device shuts down ALL of the measurement data
traffic unless there is a redundant Gateway unit present. Therefore, shut downs
of the Gateway units should be minimized.

CellSensor Driver is run as a Windows service and is automatically started and
handled by Windows.

To monitor, start, stop or restart driver select Start > Settings - Control Panel.
In Control panel select Administrative Tools = Services.
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CellSensor Driver is visible on the Windows Service list as shown in the Figure
17 below. The service status is shown in the service window’s Status column.

E Computer Managemenkt = |EI|5|
Q File  Action Wiew window  Help |_|ﬁ||5|

@ =  EHE|FDB(2|r 80w

CellSensor Driver Mame £ | Description | Status | Startup Type | Log On As | -
% .MET Runtime Optim... Microsoft ... tManual Local System
Start the service 8 flerter Matifies s, Disablad Local Service
%npplication Layer ... Provides s... tManual Local Service
Description; %Application Manage... Provides s... IManual Local System
Reads data from Outotec CellSensor %ASP.NET State Serv... Provides s... Mariual Network 5.
I;Jreot:\i'ggé.Iﬁi;r%spc(l:a;aeﬁed:tabase and %nutomatic Updates Enables th... Lisabled Local System
% Background Intellig... Transfersf... Manual Lacal System
% CellSense Estimatio. .. Aukornatic Local System
CellSensor Driver Reads dat., ., Automatic Local System
% ClipBook. Enables Cli... Disabled Local System
%COWH Event System  Supports 5., Started IManual Local System
%COI‘\H Syskem Appli... Managest... Started tManual Local System
8 Comouter Browser IMaintains &... Autornatic Local Svstem LI

Extended A Standard /

Figure 17. CellSensor Driver is managed through Windows service
management console.

Start
Select CellSensor Driver on the service list and click start button on the top tool
bar or start link on the left pane

Stop
Select CellSensor Driver on the service list and click stop button on the top tool
bar or stop link on the left pane

Restart

Select CellSensor Driver on the service list and click restart button on the top
tool bar or restart link on the left pane

OUTOTEC
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5.2 Diagnosing the System

LED Status

The CellSensor system incorporates advanced and versatile diagnostic
functions for:

= Guaranteeing measurement data validity
= Status monitoring

= System maintenance and troubleshooting

CellSensor, Coordinator and Gateway units have four LEDs (orange, yellow,
green, red) for displaying the status, configuration and activity information
locally for the users.

Status During Normal Operation

OUTOTEC

LED status indicators during normal operation are described for all CellSensor
system components in the table 7 below.

Table 7. Description for LED status

LED DEVICE STATE
Orange Yellow Green Red CellSensor Coordinator Gateway

. Boosting
Flashing Mode NA NA

Off b .

ower-saving
Off Off (Flash 1-2 Off Mode*** NA NA
times/min)
. Lost Link to

Flashing Coordinator NA NA
On Network Scan | Network Scan NA

Boosting

Mode
Flashing Coordinator NA NA
Not Found on

Power-Up
Flash > Flash > Flash > Flash. Data Send NA NA
On NA OK OK

Gateway Not No Data
On On NA Found Received™*
- Receiving Receiving
Switching On NA Data Data
(On / Off) Switching* On (On / Off) NA Sending Data Sending Data
Configuration Configuration Configuration
FIaSh FIaSh Mode**** Mode**** Mode****
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* Rate depends on the data traffic. Data is received/send when LED toggles the

value (On->Off or Off>0On)

** In 2 minutes from any Coordinator
*** Rate depends on the measurement scan interval

**** See chapter 6.3 for checking the parameters or changing the configuration

Channel Association (on Power Up)

OUTOTEC

On Power up CellSensor, Coordinator and Gateway devices go through a
power up sequence to initialise themselves. On of the main steps of the
sequence is to scan the surrounding area for Coordinator or Gateway devices
and select the best of them in case more than one is found.

The channel number of the Coordinator (for CellSensor) or Gateway (for
Coordinator), for which the device associates is displayed on right on start-up.
The four LED is are used as bits to represent channel number from 11 to 26
according to table 8 below. Since every Coordinator and Gateway typically
occupy different channels in their range, it is easy identify to which device
CellSensor or Coordinator is associating.

Table 8. The Channel Numbers Indicated by the CellSensor and Coordinator

Devices on Start-Up.

LED Associated
Orange Yellow Green Red Channel

On 11
On 12
On On 13
On 14
On On 15
On On 16
On On On 17
On 18
On On 19
On On 20
On On On 21
On On 22
On On On 23
On On On 24
On On On On 25
Flash. <Flash <Flash <Flash 26
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Diagnostic Data

Each CellSensor device monitors and transmits continuously diagnostic data up
to CellSense Server. The diagnostic data is meant to provide information on the
health of the devices, validity of the transmitted measurements and support in
troubleshooting.

All of the Diagnostic Data is available through CellSense web interface, OPC
Server or ODBC.

Bus Bar Tap Contact Status

Communication Link

CellSensor monitors to quality of the bus bar tap contacts (interface between
bus bar wire and the bus bar) with an advanced estimation algorithm. The wire
might be loose or cable broken for instance.

Should such an event occur, CellSensor alarms it by raising a
“TapContactQuality” alarm Bit: 1 = alarm, 0 = ok) until problem is fixed. This
alarm does not stop transmission of the data.

The alarm can be used in maintenance and to link it with voltage measurement
quality validation (not to be trusted) for the duration of the alarm.

The alarm will set the quality of the voltage measurements bad in the OPC
Server.

Battery Voltage

In case data is not received from a CellSensor for two minutes a
“CommunicationAlarm” is raised to inform user that the CellSensor is not able
transmit for some reason (Bit: 1=alarm, 0 = ok).

The alarm will set the quality of the voltage and temperature measurements bad
in the OPC Server. The last value received by the CellSensor Driver is
presented.

OUTOTEC

The level of the back-up battery is continuously monitored by the CellSensor.
“BatteryVoltage” is transmitted as a real number to CellSense Server. Also,
“BatteryLow Alarm” is raised in the battery voltage decreases below low limit
value (CellSensor Driver configuration file parameter).

This information can be utilized to check the battery charge levels for the
duration of long shut downs or in troubleshooting.

The battery is always and automatically re-charged and kept charged when the
cell is normally in production.
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Ambient Temperature

Ambient temperature “AmbientTemperature” of each CellSensor is constantly
measured for the many internal and safety purposes required by CellSensor.
Ambient temperature is also transmitted to CellSense Server PC for general
monitoring purposes as a real value.

CellSensor Driver

Status and execution of the CellSensor Driver can be monitored and diagnosed
with log file and from Windows service management console.

Log File

CellSensor Driver updates log file during its execution. A new log file is
generated when the Driver starts as

C:\Program Files\Outotec\CellSensor\Driver\log.txt.
The Driver writes useful information on the general system, like license
information, USB/serial port status, initialisation issues, etc. on Driver start-up.
Therefore, it is a useful tool for troubleshooting and checking the system
performance after parameter changes for instance.

The detail of the information written to log file depends on the CellSensor Driver
parameter LoglLevel_File. Different levels are described in the Table 9 below.

Table 9. Log Levels of CellSensor Driver.

Level Description

-1 Logging is disabled

0 Internal. Only internal events, warnings and failures are reported.
Minimum level.

1 Failure. Driver failures are reported

2 Critical. Critical events are reported

3 Warning. Any warnings are reported. Default level

4 Info. Driver reports successes and progress of events as it

executes. Should be used temporarily only as the log file grows
fast due to amount of information logged.

5 Debug. Driver reports very detailed information on its execution
for debugging purposes. Should be used in very special occasions
only as the log file grows very fast due to amount of information
logged.

If logging level 3 is used it contains the levels 0-2 as well, 4 contains 0-3 and so
on.

The log file can be opened with a text editor, like notepad or Microsoft Word.

OUTOTEC



User Manual

Code CSS-001

Revision 1.04 Page 53 (72)

Windows System Log

Running Status

The same information that is written to the log file can be forwarded to Windows
System log. The logging level is defined by the parameter
LogLevel_SystemEvent and adhere to levels described in Table 9.

It is recommended and good policy to keep the Windows System log level either
at 0 or 1 levels to not fill the system log with not too critical event data.

OUTOTEC

Running status of the CellSensor driver is monitored by the Windows service
management console. See chapter 5.1.3.
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6. Maintenance

Read the safety instructions of chapter 3 carefully through before maintaining
the system.

CellSensor system is light to maintain system due to simple structure, self-
diagnostics and powering. The features of the system enable on demand
maintenance for the components (act when the system indicates to do so).

Anyhow, it is recommended to perform a visual check of the devices frequently
(e.g. once per 1-3 months) to keep the system in good condition.

= Check the bus bar cable condition and taps
= Check the box mounting
= Check the status of the devices with LED information. See chapter 5.2.1

= Check the condition of the temperature probes

6.1 Replacing Components and Devices

CellSensor

OUTOTEC

This chapter provides instructions for replacing system components with a
spare. Before replacement make sure that the spare component is original and
valid (especially battery model). Refer also chapter 6.4 for product disposal
information.

A CellSensor device is replaced with a spare unit according to following
procedure:

For the CellSensor to be removed

1. Open the CellSensor box

2. Push Reset button on the CellSensor PCB board (middle and on top of the
T1 and T2 terminals).

Disconnect the battery from the battery plug J5
Disconnect the bus bar wires
Remove the temperature probes from the cells

Dismount the CellSensor box

N o o ko

Disconnect the temperature probe wires from the terminal T2

For the new CellSensor follow the standard instructions of preparing and
mounting a CellSensor device as described in the chapters 4 and 5.

Utilize the temperature probes of the old device in case they are operating
properly.
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Temperature Probe

Battery

Coordinator

OUTOTEC

1. Open the CellSensor box

2. Push Reset button on the CellSensor PCB board (middle and on top of the
T1 and T2 terminals).

Pull the plug of the terminal T2 off from the header.

Remove the probe from the cell

Disconnect the temperature probe to be removed from the terminal T2 and
pull the probe wire out via the cable fitting

For the new temperature probe follow the standard instructions of preparing and
mounting a temperature probe to a CellSensor device as described in the
chapters 4 and 5.

CellSensor utilizes re-chargeable Li-lon battery for back-up power. The battery
is re-charged whenever necessary and there is proper voltage present in the
cell. Therefore, changing of the battery is not part of the normal maintenance
procedures required for the system and should only be done when necessary
(e.g. failure of the battery).

Follow the instructions of the chapters 3.2 and 6.4 upon disposal of the failed
battery and safe handling of the battery pack.
1. Open the CellSensor box

2. Push Reset button on the CellSensor PCB board (middle and on top of the
T1 and T2 terminals)

3. Disconnect the battery from the battery plug J5 and remove it from the
battery holder

Plug the new battery to plug J5

Close the CellSensor box

For the Coordinator to be removed
1. Open the PSU box
2. Switch the mains switch to OFF (0) position

3. Disconnect the internal power cable from terminal X2 and pull them out
from the PSU box

4. Dismount the Coordinator

For the new Coordinator follow the standard instructions of preparing and
mounting the device as described in the chapters 4 and 5.

Utilize the old cabling for internal powering if reasonable.
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Gateway

For the Gateway to be removed
1. Open the PSU box
2. Switch the mains switch to OFF (0) position

3. Disconnect the internal power cable from terminal X2 and pull them out
from the PSU box

Disconnect the USB cable from the CellSense Server PC

Dismount the Gateway

For the new Gateway follow the standard instructions of preparing and
mounting the device as described in the chapters 4 and 5.

Utilize the old cabling for internal powering if reasonable.

6.2 Relocation of the CellSensors

OUTOTEC

In case a CellSensor device needs to moved from a one cell to another cell,
please follow the instructions of chapters 6.1 and 4 for removing and mounting
of the device.

Once the CellSensor device is mounted on the new cell, the new configuration
must be informed for the CellSensor Driver. There are two options for this:

= Modify the map file (easier), or

= Modify the CellSensor network address according to new location (see
chapter 6.3) and map file

To modify the map file you need the CellSensor Device network address
(labelled on the device or it can be checked with push buttons on board (see
chapter 6.3.2)):

1. Stop the CellSensor Driver. See chapter 5.2.3.2 for instructions.
2. Open Notepad Start > Run... > Type Notepad and click OK

3. Select File > Open... and browse
C:\Program Files\Outotec\CellSensor\Driver\map.csv = Open

Find the line corresponding the network address
Change the line values to match the new location at the tank or cell house
(section, cell numbers, OPC tags, etc.)

Do not edit anything else in the file!

6. Save the file. File > Save.
7. Close the file
8. Start the CellSensor Driver. See chapter 5.2.3.1 for instructions.

In case the network address of the CellSensor device was changed you need to
add a new line (copy one line as a template) and edit it according to the new
network address and plant location.
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6.3 Changing Network Setup

Entering Setup Mode

The network setup of the CellSensor, Coordinator and Gateway devices can be
modified with push buttons on the CellSensor board.

For CellSensor device only network address can be altered.

For Coordinator and Gateway devices network address and channel number
can be changed.

The system is configured and addressed before shipment, so generally altering
of the network settings should not be necessary.

Do not unnecessarily modify the network configuration settings!

To enter setup mode, push Reset Button down and then S1. Then release
Reset, after which yellow and green LEDs start to flash simultaneously. Finally,
release the S1 and the Device enters network setup mode (yellow and red
LEDs flash).

Checking the Existing Configuration

CellSensor

OUTOTEC

In Setup mode, the existing configuration of a CellSensor can be checked
according to following procedure. The 16-bit network address is shown in four
4-bit sequences. As an example address 020A is checked here from a
CellSensor.

1. Enter setup mode
2. Push S1once

3. The first 4 bits are displayed (O=off, Y=off, G=off, R=0ff) = bit value: 0000,
hex value: 0

Push S1 once. Green LED flashes twice.

The next 4 bits are displayed (O=off, Y=off, G=on, R=0ff) = bit value:
0010, hex value: 2

Push S1 once. Green LED flashes twice.

The next 4 bits are displayed (O=off, Y=off, G=off, R=0ff) > bit value:
0000, hex value: 0

Push S1 once. Green LED flashes twice.

The last 4 bits are displayed (O=on, Y=off, G=on, R=off) - bit value: 1010,
hex value: A

10. Push S1 once
11. Orange and Red LEDs are ON to show that procedure is finished

12. Push S1 once. Green LED flashes twice
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13. Push Reset to re-start the device

Coordinator and Gateway

In Setup mode, the existing configuration of a Coordinator or Gateway can be
checked according to following procedure. When compared to CellSensor, he
16-bit network address is shown in two 4-bit sequences, because the first 8 bits
of the address are always zero. So latter 8 bits are displayed.

Channel (11-26) can also be set on configuration. Use table 8 of chapter
5.2.1.3 for identifying the channel number from the LED information.

As an example address 001E is checked here from a Coordinator that is
operating on channel 15.

1. Enter setup mode

2. Push S1once

3. The first 4 bits of the address are displayed (O=off, Y=off, G=off, R=on) >
bit value: 0001, hex value: 1

Push S1 once. Green LED flashes twice.

The last 4 bits of the address are displayed (O=on, Y=on, G=on, R=off) >
bit value: 1110, hex value: E

Push S1 once. Green LED flashes twice.

The channel number is displayed as a 4 bit number. (O=off, Y=on, G=off,
R=on) - bit value: 0101 (see Table 8 of chapter 5.2.1.3)

8. Push S1 once.
9. Orange and Red LEDs are ON to show that procedure is finished
10. Push S1 once. Green LED flashes twice

11. Push Reset to re-start the device

Changing the Configuration

CellSensor

Do not unnecessarily modify the network configuration settings!

OUTOTEC

In Setup mode, the existing configuration of a CellSensor can be modified
according to following procedure. The 16-bit network address is shown in four
4-bit sequences, which can be altered in setup mode.

As an example address 020A is now changed to 110B for a CellSensor.

1. Enter setup mode

2. Push S1once

3. The first 4 bits of the old address are displayed (O=off, Y=off, G=0ff, R=0ff)
-> bit value: 0000, hex value: 0
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4. Use S2 to increment hex values from 0 to F according to new address.
Push S2 once to increment bit value 0001 (O=off, Y=off, G=off, R=on) and
hex value 1. If S2 is pushed accidentally over the desired number push S2
until numbers start from zero again (after F).

Push S1 once to accept change. Green LED flashes twice.

The next 4 bits of the old address are displayed (O=off, Y=0ff, G=on, R=0ff)
- bit value: 0010, hex value: 2

7. Use S2 to increment the value again. Push S2 once to increment bit value
0001 (O=off, Y=0ff, G=0ff, R=on) and hex value 1.

Push S1 once. Green LED flashes twice.

The next 4 bits of the old address are displayed (O=off, Y=off, G=0ff, R=0ff)
-> bit value: 0000, hex value: 0

10. Now the number does not need to be changed.
11. Push S1 once. Green LED flashes twice.

12. The last 4 bits of the old address are displayed (O=on, Y=off, G=on, R=0ff)
- bit value: 0000, hex value: A

13. Use S2 to increment the value again. Push S2 eleven times to increment
bit value to 1011 (O=on, Y=off, G=on, R=on) and hex value B.

14. Push S1 once
15. Orange and Red LEDs are ON to show that procedure is finished
16. Push S1 once. Green LED flashes twice

17. Push Reset to re-start the device

Coordinator and Gateway

OUTOTEC

In Setup mode, the existing configuration of a Coordinator or Gateway can be
modified according to following procedure. When compared to CellSensor, he
16-bit network address is shown in two 4-bit sequences, because the first 8 bits
of the address are always zero. So latter 8 bits are displayed.

Channel (11-26) can also be set on configuration. Use table 8 of chapter
5.2.1.3 for identifying the channel number from the LED information.

Be aware the range of addresses allowed for Coordinator and Gateway
devices:

= Coordinator address range 0010 — O0FE

= Gateway address range 0001 — 000E

Use of the proper address is critical, because device role, Coordinator or
Gateway, is automatically determined by the address given to the device!
As an example a Coordinator with network address 001E and operating on
channel 15 is changed to operate on channel 17.

1. Enter setup mode

2. Push S1once

3. The first 4 bits of the address are displayed (O=off, Y=off, G=off, R=on) >
bit value: 0001, hex value: 1. The address is not changed now, so
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Push S1 once. Green LED flashes twice.

The last 4 bits of the address are displayed (O=on, Y=on, G=on, R=0ff) >
bit value: 1110, hex value: E. The value is not changed now, so

6. Push S1 once. Green LED flashes twice.

The channel number is displayed as a 4 bit number. (O=off, Y=on, G=off,
R=on) - bit value: 0101 (see Table 8 of chapter 5.2.1.3)

8. Use S2 to increment hex values from 0 to F according to new channel
number (see Table 8 of chapter 5.2.1.3 for channel number translation)
Push S2 twice to increment bit value from 0101 (O=off, Y=0n, G=off, R=on)
to 0111 (17) (O=off, Y=on, G=on, R=on). If S2 is pushed accidentally over
the desired number push S2 until numbers start from zero again (after F).

9. Push S1 once.
10. Orange and Red LEDs are ON to show that procedure is finished
11. Push S1 once. Green LED flashes twice

12. Push Reset to re-start the device

6.4 Disposal of the System Components

OUTOTEC

In case any of the system components need to be disposed (e.g. due to failure
of a device), the disposal must be done in accordance with local and national
disposal regulations, including those governing the recovery and recycling of
Waste Electrical and Electronic Equipment (WEEE). See also chapter 3.2 for
more information on handling the battery.
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7. Third Party Data Interfaces

7.1 OPC Server

The measurement and diagnostic data of the CellSensor device is available via
OPC Server included in the CellSensor Driver.

The OPC Server is installed as a separate installation package from the
CellSensor Driver installation. OPC Server can be located in different PC than
CellSensor driver and it is recommended that OPC Server is installed on the
same PC than OPC Client.

CellSensor OPC Server name is OT.CellSensor.2

The OPC Server is version 2.0 compatible.

Tag Naming Convention

OUTOTEC

By default Tags are named according to following schema:
= Measurements and Diagnostics: [Group].[Section].[Data]

= Other Data: [Group].[Data]
Tags are defined in the CellSensor Driver map file (see chapter 4.5.2.1)
The values of the items are described in the table below:

Table 10. Values for Group ltem

Group Name Description
Meas Group for CellSensor measurements
Diag Group for CellSensor diagnostic data

Gateway[Name] Group for CellSensor network diagnostic data

Driver Group for CellSensor Driver status data

OPCServer Group for OPC status data

Section is defined as
s[Section number]

The Measurement Data Tag naming convention is according to following
principle (see Table 6 of chapter 4.5.2.1):

= Cell Voltage c[Cell Number]s[Sensor Number]VI

=  Temperature c[Cell Number]s[Sensor Number]Tl
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Examples:
Meas.s01.c02s01VI - Cell Voltage for Cell Number 2, Sensor 1 of Section 1.

Meas.s09.c02s01TI = Cell Temperature for Cell Number 2, Sensor 1 of Section
9.

Diagnostic Data follows the following naming convention

c[Cell Number]s[Sensor Number][Data Description]

Table 11. Items for Data Description

Group Description
CommTimeOut Communication Link status
BatteryVoltage Battery Voltage (V)
ContactBad Bus Bar Tap Contact status
BatteryLow Battery Voltage Level Low Warning
Ambient Ambient Temperature of the CellSensor

OUTOTEC
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8. Appendix 1: Technical Specifications

SYSTEM

Self-Powered Truly Wireless Voltage and
Temperature Measurement System for
Electrolytic Cells

Suitable for Cu, Zn, Ni, Co, Al Refining

Superior Data Quality through Electrically
Floating Measurement and on-board Digital
FEATURES Data Processing
Worry Free Self-Organizing and Redundant
Wireless Network

Simplified Installation and Maintenance due to
Minimized Wiring, Network Robustness and
Self Diagnostics

COMPONENTS CellSensor, Coordinator, Gateway,
CellSense Server PC

CellSensors: 1500
MAXIMUM SIZE Coordinators: 40
Gateways: 2

OPERATING TEMPERATURE 0-60°C (32-140F)

HUMIDITY 10 — 90 %, non-condensing

POWER CONSUMPTION 0.070 W Typical (Full Battery)
1 W Maximum

OUTOTEC
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STANDARDS

IEEE 802.15.4

LVD EN/IEC 61010

EMC EN 300 328

RF EN 301 489-1 and -17

FCC CRF 47 Parts 15 B and C 15.247

R&TTE 1999/5/EC

Ce

INTENDED FOR USE IN

EU, USA, Canada, Mexico, Russia, China,
Japan, Australia, India, Chile, Brazil, Peru,

South Korea, Philippines, Africa.

CELLSENSOR

INPUT
(OPERATING RANGE)

Cell Voltage: 0.16 — 4.0 VDC (0.02 — 2.00 A)
DC and PRC (Periodically Reversed Current)

Rectifiers Supported

VOLTAGE MEASUREMENT

Refining Cells: 0 - 2.5V
Electro-Winning Cells: 0 — 8 V
Resolution 0.0024 V

TEMPERATURE MEASUREMENT

Range: -55 °C — 125 °C

Accuracy: +0.5 °C

Resolution: 0.0625 °C (-10 — 85 °C)
No Calibration

BACK-UP POWER

Re-chargeable Lithium-lon Battery

Panasonic CGR18650CF1S1P
(2350 mAh / 3.6V)

Integrated Safety Circuit by Fey
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DIAGNOSTICS Local LEDs for Status

via CellSense / OPC Server:

Poor Tap Contact (Wire to Bus)
Battery Low Level
Communication Link

Ambient Temperature

COORDINATOR AND GATEWAY

100 — 240 VAC, 50 -60 Hz,0.2-04A

INPUT

0.5 A external fuse or circuit breaker required.
NETWORK
MODULATION DSSS (Direct Sequence Spread Spectrum)
TRANSMISSION POWER 0 dBm
FREQUENCY 2.400 - 2.483 GHz
STANDARDS IEEE 802.15.4

PROTECTION AND MATERIALS

SEALING CLASS IP65 (NEMA 4)

Polycarbonate
CASING Stainless Steel (AISI316)
PVDF

OUTOTEC
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TEMPERATURE PROBE

Stainless Steel (AlSI316)
Polypropylene Coating
Wire length 1.5 m

BUS BAR WIRES

0.5m-2.0m/Bus
Cu -4 mm? (AWG 12), PVC
HO7V-K-4, UL Style 1015/1283/1284

DIMENSIONS

CELLSENSOR (W x D x H) (mm)
COORDINATOR

GATEWAY 168 x 140 x 80

TEMPERATURE PROBE

(L x Diam.) (mm)

1000 x 6
CELLSENSE SERVER

Minimum Requirements:

Intel Pentium >3 GHz or Dual Core
SERVER 2 GB RAM

2 X 72 GB HDD (RAID-1)
Ethernet (100/1000 Mbps)

OPERATING SYSTEM

Windows Server 2003

SOFTWARE

Microsoft SQL Server 2005
Microsoft Office 2003

Microsoft IS Web Server (included in Win

2003)

Microsoft .NET Framework 1.1 and 3.0
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CellSense Monitoring System
ODBC (SQL)

OPC Server

Custom Interfaces on Request

DATA INTERFACES

OUTOTEC
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9. Appendix 2: General Wiring Diagrams

See Attached Files.

OUTOTEC
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10. Appendix 3: Description of the Communication
Port and USB cable

Description of the communication port J3 are defined in the Table and picture
below. The portis 3.3 V TTL and it connects to CellSense Server PC with an
USB cable.

The port J3 is used by Gateway devices only.
Do not connect any other cable than what has been supplied with the
system to the J3 port pins! Use only the pins/signals described in the
table below. Connecting wrong cables, signals or signal levels may cause
malfunction of the device and avoid warranty.

J3 Pin Description

CTS (Pin 10) Rx (Pin5)

RTS (Pin 9) Tx (Pin 4)

GND (Pin 8)

- (Pin 1)
CTS Rx
RTS Tx
GND
PIN 1

USB Cable type is TTL-232R-3V3 USB to Serial Cable (3.3V) with integrated
FTDI Chip for TTL to USB converter in the USB plug. The USB is version 2.0
compatible. The cable and the signals are described in Figure below.

OUTOTEC
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TTL (3 .3V)

-~
-

Orange (Tx) o

velow (24 _/-\[ - use 20)

Erown (CTS) ‘

Green (RTS) '
TTL/ USE Converter

Elack (GND]

The USB adapter cable wires are connected with port J3 according to following

table:
USB Adapter Wire J3 Pin
Orange (Tx) 5 (Rx)
Yellow (Rx) 4 (Tx)
Black (GND) 8 (GND)
Brown (CTS) 9 (RTS)
Green (RTS) 10 (CTS)

OUTOTEC
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11. Appendix 4: FCC Information to User

Federal Communications Commission (FCC) Statement
15.21

You are cautioned that changes or modifications not expressly approved by the
part responsible for compliance could void the user’'s authority to operate the
equipment.

15.105(b)

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.
= Increase the separation between the equipment and receiver.

o Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

= Consult the dealer or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:
1) this device may not cause interference and

2) this device must accept any interference, including interference that may

cause undesired operation of the device.

FCC RF Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. End users must follow the specific operating
instructions for satisfying RF exposure compliance. This transmitter must not be
co-located or operating in conjunction with any other antenna or transmitter.

OUTOTEC
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12. Appendix 5: IC Information to User

OUTOTEC

Industry Canada (IC) Statement
15.21

You are cautioned that changes or modifications not expressly approved by the
part responsible for compliance could void the user’'s authority to operate the
equipment.

15.105(b)

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to part 15 of the IC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.
= Increase the separation between the equipment and receiver.

o Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

= Consult the dealer or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:
1) this device may not cause interference and

2) this device must accept any interference, including interference that may

cause undesired operation of the device.

IC RF Radiation Exposure Statement:

This equipment complies with IC radiation exposure limits set forth for an
uncontrolled environment. End users must follow the specific operating
instructions for satisfying RF exposure compliance. This transmitter must not be
co-located or operating in conjunction with any other antenna or transmitter.
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READER COMMENTS

The design team of Outotec is committed to ensure the quality and usefulness of this manual
and the CellSensor system. Your comments, recommendations and suggestions will help
make our continuous effort more effective.

Please take few moments to write your comments either directly on the form provided or on a
photocopy of it.

Your assistance is greatly appreciated.
Thank you for choosing the CellSensor system.

OUTOTEC, Base Metals

Fax to: FAX: INT + 358 20 529 2992

or mail to: P.O. Box 86, FIN-02201 Espoo, Finland
or e-mail to: hydro@outotec.com

Attn: Manager, CellSensor System

From:

Serial Number (License

Key):
Manual: CellSensor System
User Manual
Code CSS-001 Revision 1.04
( Please identify applicable software versions and individual
documents )
Comments /
recommendations:

Number of additional pages ( )
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